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Find-a-Gene Project Assignment

A total of 20% of the course grade will be assigned based on the
“find-a-gene project assignment”

* The objective with this assignment is for you to demonstrate your
grasp of database searching, sequence analysis, structure analysis
and the R environment that we have covered to date in class.

* You may wish to consult the scoring rubric (in the linked project

description) and the example report for format and content
guidance.

= Your responses to questions Q1-Q4 are due at the beginning of
class Friday May 18th (05/18/18).

= The complete assignment, including responses to all questions,
is due at the beginning of class Wed June 1st (06/01/18).

[ MPA Responses

[ Kevin’s StackExchange Link ]

Thanks Kevin!

Questions:

Q1] Tell me the name of a protein you are interested in. Include the species and the accession
number. This can be a human protein or a protein from any other species as long as its function
is known,

If you do not have a favorite protein, select human RBP4 or KIF11. Do not use beta globin as
this is in the worked example report that | provide you with online.

Q2] Perform a BLAST search against a DNA database, such as a database consisting of
genomic DNA or ESTs. The BLAST server can be at NCBI or elsewhere. Include details of the
BLAST method used, database searched and any limits applied (e.g. Organism)

Al the output of that BLAST search in your document. If appropriate, change the font
to Courier size 10 so that the results are displayed neatly. You can also screen capture a
BLAST output (e.g. alt print screen on a PC or on a MAC press 3-shift-4. The pointer becomes
abulls eye. Select the area you wish to capture and release. The image is saved as a file called
Screen Shot [].png in your Desktop directory). Itis not necessary to print out all of the
blast results if there are many pages.

On the BLAST results, clearly indicate a match that represents a protein sequence,
encoded from some DNA sequence, that is homologous to your query protein. | need to
be able to inspect the pairwise alignment you have selected, including the E value and
score. It should be labeled a "genomic clone" or "mRNA sequence”, etc. - but include no
functional annotation

In general, [Q2] is the most difficult for students because it requires you to have a “feel”
for how to interpret BLAST results. You need to distinguish between a perfect match to

your query (i.e. a sequence that is not “novel”), a near match (something that might be

“novel”, depending on the results of [Q4]), and a non-homologous result.

If you are having trouble finding a novel gene try restricting your search to an organism
that is poorly annotated.

Q3] Gather information about this “novel” protein. At a minimum, show me the protein
sequence of the “novel” protein as displayed in your BLAST results from [Q2] as FASTA
format (you can copy and paste the aligned sequence subject lines from your BLAST
result page if necessary) or translate your novel DNA sequence using a tool called
EMBOSS Transeq at the EBI. Don't forget to translate all six reading frames; the ORF
(open reading frame) is likely to be the longest sequence without a stop codon. It may
not start with a methionine if you don't have the complete coding region. Make sure the
sequence you provide includes a header/subject line and is in traditional FASTA format.

Here, tell me the name of the novel protein, and the species from which it derives. It is
very unlikely (but still definitely possible) that you will find a novel gene from an
organism such as S. cerevisiae, human or mouse, because those genomes have
already been thoroughly annotated. It is more likely that you will discover a new gene in
agenome that is currently being sequenced, such as bacteria or plants or protozoa.

[Q4] Prove that this gene, and its corresponding protein, are novel. For the purposes of
this project, “novel” is defined as follows. Take the protein sequence (your answer to
[Q3]), and use it as a query in a blastp search of the nr database at NCBI.

 If there is a match with 100% amino acid identity to  protein in the database, from the
same species, then your protein is NOT novel (even if the match is to a protein with a
name such as “unknown”). Someone has already found and annotated this sequence,
and assigned it an accession number.

+ If the top match reported has less than 100% identity, then it is likely that your protein
is novel, and you have succeeded.

 If there is a match with 100% identity, but to a different species than the one you
started with, then you have likely succeeded in finding a novel gene.

 If there are no database matches to the original query from [Q1], this indicates that
you have partially succeeded: yes, you may have found a new gene, but no, it is not
actually homologous to the original query. You should probably start over.

Q5] Generate a multiple sequence alignment with your novel protein, your original
query protein, and a group of other members of this family from different species. A
typical number of proteins to use in a multiple sequence alignment for this assignment
purpose is a minimum of 5 and a maximum of 20 - although the exact number is up to
you. Include the multiple sequence alignment in your report. Use Courier font with a size
appropriate to fit page width.

Side-note: Indicate your sequence in the alignment by choosing an appropriate name
for each sequence in the input unaligned sequence file (i.e. edit the sequence file so
that the species, or short common, names (rather than accession numbers) display in
the output alignment and in the subsequent answers below). The goal in this step is to
create an interesting an alignment for building a phylogenetic tree that illustrates
species divergence.




What is Git?

(1) An unpleasant or contemptible
person. Often incompetent,
annoying, senile, elderly or
childish in character.

(2) A modern distributed version
control system with an emphasis
on speed and data integrity.

What is Git?

(1) An unpleasant or contemptible
person. Often incompetent,
annoying, senile, elderly or
childish in character.

(2) A modern distributed version ®
control system with an emphasis 0 glt

on speed and data integrity.

Version Control

Version control systems (VCS) record changes
to a file or set of files over time so that you can
recall specific versions later.

Free/open-source CVS (1986, 1990 in C) - CVSNT (1998) - QVCS Enterprise (1998) - Subversion (2000)

Software Change Manager (1970s) « Panvalet (1970s) + Endevor (1980s) - Di
e (1980s) - DSEE (1984) - Synergy (1990) - ClearCase (1992) - CMVC (1994) «
Proprietary  (1994) - Perforce (1995) - StarTeam (1995) - Integrity (2001) - Surround SCM (2002) «
AccuRev SCM (2002) - SourceAnywhere (2003) « Vault (2003) - Team Foundation Server (2005)
Team Concert (2008)
GNU arch (2001) - Darcs (2002) - DCVS (2002) - ArX (2003) - Monotone (2003) + SVK (2003) «
Free/open-source | X N _ X
Distributed Codeville (2005) - Bazaar (2005) - Git (2005) - Mercurial (2005) « Fossil (2007) + Veracity (2010)

Proprietary TeamWare (1990s?) - Code Co-op (1997) - BitKeeper (1998) - Plastic SCM (2006)

There are many VCS available, see:
https://en.wikipedia.org/wiki/Revision_control




Client-Server vs Distributed VCS
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Client-server approach Distributed approach

Distributed version control systems (DCVS) allows
multiple people to work on a given project without
requiring them to share a common network.

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down”

~T HEY! GET BACK

Git is now the most popular free VCS!

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down” Git offers:

— Speed

—( HEY! GET BACK Backups
Off-line access
Small footprint
Simplicity*
Social coding

Vﬁ's dO\;l;\b
£ —

Written initially by Linus Torvalds to
support Linux kernel and OS
development.

Meant to be distributed, fast and
more natural.

Capable of handling large projects.

Now the most popular free VCS!




Why use Git?

Q. Would you write your Llab boolk in
pencil, then erase and overwrite ik
every ciouj with new conbkent?

Version control is the lab notebook of the digital
world: it's what professionals use to keep track of
what they’ve done and to collaborate with others.

Q. Would you write your Llab boolk in
pencil, then erase and overwrite it
every ciouj with new conbkent?

Why use Git?

Provides ‘snapshots’ of your project during development
and provides a full record of project history.

Allows you to easily reproduce and rollback to past
versions of analysis and compare differences. (N.B. Helps
fix software regression bugs!)

Keeps track of changes to code you use from others such
as fixed bugs & new features

Provides a mechanism for sharing, updating and
collaborating (like a social network)

Helps keep your work and software organized and available




Obtaining Git

. Note: You might already have git installed ;
: To check open the “Terminal” tab in RStudio and type:

which git

i Windows
Follow the GitBash instructions here:
 https://bioboot.github.io/bimm143_S18/setu

i Mac & Linux
Download git directly from here:

! https://git-scm.com/downloads

Note: You might already have git installed

ETo check open the “Terminal” tab in RStudio and type:

which git

Obtaining Git

Configuring Git




Configuring Git
(RStudio Terminal Tab)
(...or RStudio > Tools > Shell)

# First tell Git who you are
> git config --global user.name “Barry Grant”
> git config --global user.email “bjgrant@ucsd.edu”

Using Git

1. Initiate o Git repository,
2. Edit content (iLe. change some files).
3, Store a ‘snapsho&' of the current file state.*

Using Git with
RStudio

Go to: RStudio > Tools > Global Options > Git/SVN

1 Make sure this is ticked!
2 Make sure this is correct!

Checkin your RStudio “Terminal” tab:

Console =~ Terminal Markdown
Terminal '~ | another

blitz: > which git

/usr/local/bin/git

blitz: >




Create a new
RStudio project

1 New option to create
a Git repository...

2 New Git tab..
N\,

&

Create New Project Environment  History ~ Connections = Git., [

Dircetery name E piff  Hl Commit Qo o -

Test]

Staged Status Path
(] B B _.gitignore
[ ] B B test.Rproj

Create project s gibdirectary of

[Mcreate « git rep

[T Use packrat wr

Creats Project Cancel

L}
‘

Check if new Git options appear in RStudio?

Pelitic

THE WYALL ESTREET : Sli FOR 12 WEEKS

e Real Eslate Q

YOU AREREADING A PREVIEW OF A PAID ARTICLE. [JETECCIITM T0 GET MORE GREAT CONTENT.
e
GitHub Raises $250 Million at $2 Billion
Valuation

Capital raise puts company's total funding at $350 million

Analytics
low does your organization’s
alent measure up

‘@ its technology?
& f
A

— https://github.com -

GitHub & Bitbucket

GitHub and Bitbucket are two popular hosting services for
Git repositories. These services allow you to share your
projects and collaborate with others using both ‘public’ and
‘private’ repositories”.

o https://bitbucket.org _

Q

What is the big deal?

At the simplest level GitHub and Bitbucket offer backup of
your projects history and a centralized mechanism for
sharing with others by putting your Git repo online.

* GitHub in particular is often referred to as the “nerds
FaceBook and LinkedIn combined”.

At their core both services offer a new paradigm for open
collaborative project development, particularly for software.

* |In essence they allow anybody to contribute to any
public project and get acknowledgment.




First sign up for a GitHub account
https://github.com

Explore Foatures Enterprise  Pricing

Build software
better, together.

Powerful collaboration, code review, and code management for
open source and private projects. Public projects are always free.

Pick the FREE plan!

Pull recuests Issues  Gist

Welcome to GitHub

You'va laken your first step inio a larger world, @biobootStudent.

Completed (p Sz

Sct up u personyl Chooeic your pian

Choose your personal plan
Each plan includes:

Plan Cast Privale repositorics
Unlimited col st:orators

Large Ssfrontt &0 e
Unlimited putic recositor es

Modiwm  S2frontt %0
Free setup

Small Si2frontt 10 ~ HTTPS Protastior

Emall supoort

Miore, Sszimonly 5
Wiks, Issues, Pages, & more

Your GitHub homepage

Check your email for verification request

Pull recquests Issues  Gist

Pra tip: updating your prcfile wih your name, location, and a Fofile piciure neips other
Gitlub users get to krow you

[E Contritutions £ Rapositories

Contributions.

biobootStuden

Jdeined o Aug 28, 2015

i Leser how s Loss (1]

e ™ This Is your contribution graph. When you make a commit to a regoshory, you'll get a = for that
ntributions and you'll get a darker green square. Over tme, your charl might
mething like this
w side thal will show you how 1o creete your first repository. You'l also meke a
commil and cam your first green square!

I+ Read the Kella Viorld guide

Pull requests lssues  Qist

Learn Git and GitHub without any code!

h te commants, and open a pull requast

biobootstudent Your repositories.

Welcome 1o GilHubl What's next?

ProTip! it your 1aad by Updaling the L<ars you o ko and “apo




Name your repo
bggn213

Pull requests  Issues  Marketplace Explore

Create a new repository

A rapository contains all the filas for your project, including tha revision history.

Owner Repository name
bicboot~ £ bimm143
Graat repasitory names are shart anc memoracie. Nead inspiraticn? Hew about cuddly-invention.

Description (optiorsai)

Public

Anyene can see thls reposiory. Yeu choo:
Private

Vou choosa whe can sea and commit to this repostiory.

« Iniflalize this repository with a README

GV will [t you immadiately clone 1ha repository to your computer. Skip this step i y

Add gilignore: Nane Add 4 licersse: Non ®

Create

Copy the “Clone” HTTPS

O This repository Pull requests lssues Marketplace Explore

bioboot / bimm143

@ unwaten ~

<3 Code Pull requests 0 Projects 0 v nsights Settings
No description, website, or topics provided.
Add topics

D1 commi ¥ 1 branch 0 releases 42 1 contributor

Brench: master ~  New pull request Create new file ~ Upload files  Find filgf [CITITE S L R g

L. bioboot Iniial com

Clone with HTTPS & Lea SSH
README.md . Ise Git or checkout with SYN using the web URL,

https://qithub. con/bioboot/binm143.aif &2

&) README.md

Open in Desktop Download ZIP

bggn213

RStudio > New Project > Version Control

New Project

Create Project

[ New Directory
R

Start a project in a brand new working directory

Existing Directory
Associate a project with an existing working directory

Version Control
Checkout a project from a version control repository

Cancel

RStudio > New Project > Version Control

New Project

Back Clone Git Repository

Repository URL: GitHub

https://github.com/bioboot/bggn213.git Paste

Project directory name:
bggn213_github
Create project as subdirectory of.

~/Desktop/courses/bggn213_S18 Browse...

v[Open in new session Create Project




Demo of editing, adding
committing and pushing

Check if new Git tab
Appears in RStudio?

Environment  History Connections GE ()
B piff = Bl Commit Q- Now experiment editing the
Staged Status Path README.md file in RStudio
® BE@E gitgnore and adding, committing and
@ BB testRoroj pushing changes to GitHub
\ERGLIERE]

Side-note: How to edit online

Specifically lets add some Markdown content

Q[
blobootStudent / demo1_glthub

demal_github / README

Demo of editing, adding
committing and pushing

Check if new Git tab

Appears in RStudio?

Now experiment editing the
Environment  History ~ Connections  Git., =] README.md file in RStudio
B piff = Bl Commit © ! and adding, committing and

Staged Status Path pushing changes to GitHub

s B B _gitignore via this tab
] B B testRproj

When you are ready copy your
different class directories/projects
to this new GitHub tracked folder

Summary

Git is a popular ‘distributed’ version control
system that is lightweight and free

GitHub and BitBucket are popular hosting
services for git repositories that have changed the
way people contribute to open source projects

Introduced basic git and GitHub usage within
RStudio and encouraged you to adopt these ‘best
practices’ for your future projects.




Learning Resources Learning git can be painful!

Set up Git. If you will be using Git mostly or entirely via However in practice it is not nearly as crazy-making as
GitHub, look at these how-tos. the alternatives:
< https://help.github.com/categories/bootcamp/ >

, , Documents as email attachments
Getting Git Right. Excellent Bitbucket git tutorials

< https://www.atlassian.com/qit/ >

Hair-raising ZIP archives containing file salad

Pro Git. A complete, book-length guide and reference to Git, ) )
by Scott Chacon and Ben Straub. Am | working with the most recent data?

< http://git-scm.com/book/en/v2 >

Archaelogical “digs” on old email threads and

StackOverflow. Excellent programming and developer Q&A. uncertainty about how/if certain changes have been
< http://stackoverflow.com/questions/tagged/qit > made or issues solved

Finally Please remember that GitHub
and BitBucket are PUBLIC and that

you should cultivate your professional
and scholarly profile with intention!

[ Muddy Point Assessment |




Reference Slides Using Command Line Git

1. Initiate a Git reposi.&or .
2. Edit content (iLe. change some files).
3. Store a ‘snapshot’ of the current file state.*

Initiate a Git repository Initiate a Git repository

> cd ~/Desktop

> mkdir git_class # Make a new directory

> cd git_class # Change to this directory
> git init # Our first Git command!
> |s -a # what happened?




Side-Note: The .git/ directory

Git created a ‘hidden’ .git/ directory inside your
current working directory.

You can use the ‘Is -a’ command to list (i.e. see)
this directory and its contents.

This is where Git stores all its goodies - this is Git!

You should not need to edit the contents of the .git
directory for now but do feel free to poke around.

Important Git commands

git status

# report on content changes

git add <filename>  # stage/track a file
git commit -m “message” # snapshot

You will use these three commands again and again in your Git workflow!

)

Important Git commands

git status  # report on content changes

git add <filename>  # stage/track a file
git commit -m “message” # snapshot

Git TRACKS your directory content

» To get a report of changes (since last commit) use:
> git status

* You tell Git which files to track with:
> git add <filename>

This adds files to a so called STAGING AREA
(akin to a “shopping cart” before purchasing).

* You tell Git when to take an historical SNAPSHOT of
your staged files (i.e. record their current state) with:

> git commit -m ‘Your message about changes’




Example Git workflow

Eva creates a README text file

(this starts as untracked)

Adds file to STAGING AREA*
(tracked and ready to take a snapshot)

Commit changes*
(records snapshot of staged files!)

Eva creates a README file

> # cd ~/Desktop/git_class
> # git init

> echo "This is a first line of text." > README
> git status # Report on changes

zOn branch@

# Initial commit

#

#iUntracked files:i

# (Use"git add <file>..." to include in what will be committed)
#

#

#
# nothing added to commit but untracked files present (use "git add" to track)

Example Git workflow

Eva creates a README text file

Adds file to STAGING AREA*

Commit changes*

Eva modifies README and adds a ToDo text file
n Adds both to STAGING AREA*

Commit changes*

2. Adds to ‘staging area’

> gitadd README  # Add README file to staging area
> git status # Report on changes

# On branch master
#

# Initial commit

#
#{Changes to be committed:

# (use 'git rm --cached <file>..." to unstage)

new file: README




3. Commit changes

> git commit -m “Create a README file” # Take snapshot
# [master (root-commit) 8676840] Create a README file

# 1 file changed, 1 insertion(+)

# create mode 100644 README

> git status # Report on changes

# On branch master
# nothing to commit, working directory clean

5. Adds both files to ‘staging area’

> git add README ToDo # Add both files to ‘staging area’
> git status # Report on changes
# On branch master

# Changes to be committed:
(use "git reset HEAD <file>..." to unstage)

modified: README
new file: ToDo

4. Eva modifies README file
and adds a ToDo file

> echo "This is a 2nd line of text." >> README
> echo "Learn git basics" >> ToDo

> git status # Report on changes

# On branch master
#
# Changes not staged for commit:
(use "git add <file>..." to update what will be committed)
(use "git checkout -- <file>..." to discard changes in working directory)

modified:

#
#
#
#
# Untracked files:

# (use 'git add <file>..." to include in what will be committed)
#

#

#

#

no changes added to commit (use "git add" and/or "git commit -a")

6. Commits changes

> git commit -m "Add ToDo and modify README"

# [master 7b679fa] Add ToDo and modify README
# 2 files changed, 2 insertions(+)
# create mode 100644 ToDo

> git status

# On branch master
# nothing to commit, working directory clean




Example Git workflow

Eva creates a README text file

Adds file to STAGING AREA*

Commit changes*

4. E Eva modifies README and adds a ToDo text file
N

5. P Adds both to STAGING AREA*

6

Commit changes*

...But, how do we see the history of our project changes?

git log: Timeline history of
snapshots (i.e. commits)

> git log

# commit 7b679fa747e8640918fcaad7e4c3f9c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

#

# Add ToDo and finished README

#

# commit 86768401610770ae32e2fd4faece07d1d5¢c68619¢
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

#

# Create a README file

#

git log: Timeline history of
snapshots (i.e. commits)

> git log

# commit 7b679fa747e8640918fcaad7e4c3f9c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

#

# Add ToDo and finished README

#

# commit 86768401610770ae32e2fd4faece07d1d5¢c68619¢
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

#

# Create a README file

#

Side-Note: Git history is akin
to a graph

Nodes are commits labeled by their
unigue ‘commit ID’.

(This is a CHECKSUM of the commits
author, time, commit msg, commit content
and previous commit ID).

HEAD is a reference (or ‘pointer’) to the
currently checked out commit (typically the
most recent commit).




Projects can have complicated
graphs due to branching

Master Feature

5906. ..
1g9KkK...

8696

Branches allow you to work independently
of other lines of development we will talk
more about these later!

Summary of key Git commands:

> git status # Get a status report of changes since last commit

> git add <filename> # Tell Git which files to track/stage

> git commit -m ‘Your message’ # Take a content snapshot!

> git log # Review your commit history

> git diff <commit.ID> <commit.ID> # Inspect content differences

> git checkout <commit.ID> # Navigate through the commit history




‘Staging Local
Area’ Repository

status

git diff: Show changes
between commits

> git diff 7b67 8676

# diff --git a/README b/README

# index 67bd82c..73bc85a 100644
# --- a/README

# +++ b/README

#@@-12 +1 @@

# This is a first line of text.

#

# diff --git a/ToDo b/ToDo

# deleted file mode 100644
# index 14fbd56..0000000
# --- a/ToDo

# +++ /dev/null

#@@1 +0,0 @@

#

git diff: Show changes
between commits

> git diff 8676 7b67

# diff --git a/README b/README

# index 73bc85a..67bd82c 100644
# --- a/README

# +++ b/README

# Q@@ -1 +1,2 @@

# This is a first line of text.

# +This is a 2nd line of text.

# diff --git a/ToDo b/ToDo
# new file mode 100644

# index 0000000..14fbd56
# --- /dev/null

# +++ b/ToDo

# @@ -0,0 +1 @@

# +Learn git basics

git diff: Show changes
between commits

> git diff 8676 ## Difference to current HEAD position!

# diff --git a/README b/README
# index 73bc85a..67bd82c 100644

*

# — a/README
# +++ D/README m 7687 ...

# Q@@ -1 +1,2 @@
# This is a first line of text.
# +This is a 2nd line of text.

# diff --git a/ToDo b/ToDo
# new file mode 100644

# index 0000000..14fbd56
# --- /dev/null

# +++ b/ToDo

# @@ -0,0 +1 @@

# +Learn git basics




HEAD advances automatically with

each new commit

m 7‘7- . To move HEAD (back or forward)

on the Git graph (and retrieve the
associated snapshot content) we
can use the command:

> git checkout <commit.ID>

8@6...

git checkout: Moves HEAD
(e.g. back in time)

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline
# 7b679fa Add ToDo and finished README
# 8676840 Create a README file

> git checkout 86768
# You are in 'detached HEAD' state...<cut>...
# HEAD is now at 8676840... Create a README file

> more README
This is a first line of text.

> git log --oneline
# 8676840 Create a README file

git checkout: Moves HEAD

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline
# 7b679fa Add ToDo and finished README
# 8676840 Create a README file

git checkout: Moves HEAD
(e.g. back to the future!)

> git checkout master
# Previous HEAD position was 8676840... Create a README file
# Switched to branch ‘master’

> git log --oneline m 7‘7
# 7b679fa Add ToDo and finished README "'

# 8676840 Create a README file

> more README
This is a first line of text.
This is a 2nd line of text.

8@6...




Side-Note: There are two* main ways to You can discard revisions
use git checkout with git revert

Checking out a commit makes the entire working * The git revert command undoes a committed
directory match that commit. This can be used to snapshot.
view an old state of your project.
» But, instead of removing the commit from the
> git checkout <commit.ID> project history, it figures out how to undo the
changes introduced by the commit and appends

Checking out a specific file lets you see an old a new commit with the resulting content.
version of that particular file, leaving the rest of
your working directory untouched. > git revert <commit.|D>

> git checkout <commit.ID> <filename> * This prevents Git from losing history!

Removing untracked files
with git clean

The git clean command removes untracked files from
your working directory.

Like an ordinary rm command, git clean is not
undoable, so make sure you really want to delete the
untracked files before you run it. Tower (Mac only)
GitHub_Desktop (Mac, Windows)
> git clean -n # dry run display of files to be ‘cleaned’ SourceTree (Mac, Windows)
SmartGit (Linux)

> git clean -f # remove untracked files RStudio

https://git-scm.com/downloads/quis




